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GETTING STARTED

GETTING STARTED
Exclusive to the Cutout Maker 2800, the VariQuest® Design Center Software 
now offers the MyShape™ feature for those looking to import and cut their own 
creations using the VariQuest® Cutout Maker Digital Die-Cut Machine! This 
guide walks through the recommended design process for creating cut shapes 
compatible with the Cutout Maker 2800, and shares helpful information to 
ensure a shape will cut as the designer intended.

Document Setup
The VariQuest® Design Center Software requires a vector graphic for the MyShape™ feature, and is 
currently only compatible with the Adobe® Illustrator® file format. A vector graphic created with any other 
platform will need to be opened and saved out as an Adobe Illustrator file.

Note: Adobe Illustrator files will need to be saved down to Illustrator Version 3 in order to be uploaded using the 
MyShape feature. See Saving & Exporting for more details.

When creating a new document for designing a cut shape, or when opening an existing vector graphic in 
Adobe Illustrator, it is important to consider the smallest size the shape should be cut at. The size of the 
artwork in the document, when imported into the software, will be designated the minimum cut size for 
that shape. If an attempt is made to cut the shape smaller than the size it was imported at, the VariQuest 
software will issue a warning message informing the user that a shape is being cut smaller than the 
minimum cut size. A good starting point for most shapes is 4″ by 4″, and should increase based on 
complexity. 

Note: Cutting shapes smaller than 2″ by 2″ is not recommended. Any shape imported smaller than this will 
automatically size up to 4″ wide when added to a cut job.

Once a document for the cut shape has been created or adjusted, there are several different ways to 
proceed to utilize the MyShape feature. 

https://www.adobe.com/products/illustrator.html
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DESIGN PROCESS
A basic shape can be achieved by tracing a flat image (JPEG, PNG, PDF, etc.), using the Adobe® 
generative AI feature, or by manipulating an already existing vector graphic.

Note: The following section goes through in-depth examples for designing new, or manipulating existing 
vector graphics to import as cut shapes for the Cutout Maker 2800 using the MyShape™ feature in the 
VariQuest® Design Center Software. If using a vector graphic that has already been designed and 
formatted as a basic shape, go to File Formatting in the Saving & Exporting section, or skip directly 
to Importing to learn how to import and save the file to the MyShape directory.

Designing a Shape Using Image Trace
To trace a flat image (such as a JPEG or PNG file), in the newly created 
Adobe® Illustrator® document, go to File, click Place, browse out and select 
the desired image. Once the image is placed on the artboard, it can be traced 
manually by plotting individual anchor points, or the process can be sped up 
by using the Image Trace feature.

To utilize this feature, make sure the Image Trace panel is open in the 
document’s workspace by going to Window and selecting Image Trace.

1.	 Select the image that has been placed on the artboard

2.	 Open the Image Trace panel

3.	 Select Black and White Logo from the Preset 
drop-down menu

Note: It is important to stick to only 2 colors when designing 
a cut shape. One color (in this case - black) will 
represent the main shape, while the second color (white) 
designates the relief areas that will be cut away.

4.	 Toggle the Threshold slider to desired effect

Note: The desired effect in this step should consider the 
criteria discussed later in the Formatting section.
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5.	 Expand the Advanced section in the Image Trace panel and make 
sure the Overlapping  method is selected

Note: Adobe® Illustrator® must be updated to Version 2025 (29.0 or higher) in 
order to access the Advanced section of the Image Trace Panel.

6.	 Once the the desired effect has been achieved, click the Expand 
button on the Image Trace panel; or go to Object, select Image Trace, 
and click Expand

7.	 Right click on the expanded image and select Ungroup (Ctrl+Shift+G)

8.	 Select the background and delete any object surrounding the image

Note: The Image Trace feature creates 
objects out of all elements in an 
image—for example—a PNG image of 
a circular logo, although it may have 
a transparent background, will render 
the blank space around an image as a 
white object. This object needs to be 
deleted, or the Cutout Maker will treat 
the outline as a path to be cut.

The resulting image is now ready to be tweaked and formatted into a compatible shape that can be 
imported into the VariQuest® Design Center software and cut with the VariQuest Cutout Maker 2800 
MyShape™ feature. See the Formatting section for more details.

https://www.adobe.com/products/illustrator.html
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Designing a Shape Using Generative AI
Using Adobe® Firefly® technology, Adobe Illustrator® offers generative AI as a way to generate vector 
graphics with a simple prompt. When the right process is followed, these vector graphics may be 
converted to cut shapes compatible with the Cutout Maker 2800 MyShape™ feature. This section walks 
through the recommended process for using generative AI with Adobe Illustrator Version 2025.

To use generative AI to create a vector graphic for desiging 
basic shapes, use the Rectangle tool  (M) to draw a 
rectangle shape that encompasses the entire artboard.

1.	 Making sure the rectangle shape is selected, click the 
Enhanced Text to Vector Graphic button  in the 
control bar at the top of the document

2.	 Enter a prompt and select preferences in the Generate 
Vectors dialogue box

a.	 Type a clear, detailed prompt for the desired 
shape in the Prompt box

b.	 Select Icon under Content Type

c.	 Toggle the slider under Detail to Minimum

d.	 If possible, it is recommended to use a 
Style Reference from the VariQuest® 
Design Center Software—this can be 
achieved by taking a screenshot of a 
similar shape in the software, pasting it 
onto the current document, converting 
the screenshot to a vector graphic using 
Image Trace (See Designing a Shape 
Using Image Trace), and selecting the 
resulting graphic as the Style Reference 
in the Generate Vectors dialogue box

e.	 Select Flat Design as the Effect

f.	 Choose the Black and White preset under 
Color and Tone, and select 2 as the No. of 
Colors for the image

Note: It is important to stick to only 2 colors when 
designing a cut shape. One color (in this case - 
black) will represent the main shape, while the 
second color (white) designates the relief areas 
that will be cut away.

3.	 Once all selections are made in the Generate Vectors dialogue box, click Generate

https://www.adobe.com/products/firefly.html
https://www.adobe.com/products/illustrator.html
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Designing a Shape Using an Existing Vector Graphic
If a vector file already exists for an image, some additional formatting may be necessary to convert the 
graphic into a cut shape compatible with the Cutout Maker 2800. Depending on the complexity of the file, 
this avenue may require the most amount of design skill and experience working with vector graphics 
and the Adobe® Creative Suite®.

Note: A simplified method of working with a pre-existing vector graphic may be to Rasterize (Object > Rasterize) 
the image and follow the steps for Designing a Shape Using Image Trace.

A best practice when working with a pre-existing vector graphic is to first open the file in another Adobe 
Illustrator® window.

1.	 Locate any objects with a gradient fill and replace with a solid fill color

Note: Objects with a gradient fill, if not converted to a solid fill, will be expanded upon import and appear inverted in 
the software, causing the shape to fail to cut properly.

4.	 Review the variations generated in the Properties panel and 
select the most desirable option

Note: If none of the options presented are suitable, click Generate 
again. If a desirable option still has not been generated, consider 
tweaking the prompt text or choosing a different Style Reference, 
and generate again.

5.	 Expand the newly generated image by selecting the artwork, 
going to Object and selecting Expand

Note: If Expand is disabled in the Object menu, click Expand 
Appearance—go back to Object and select Expand.

The resulting image is now ready to be tweaked and 
formatted into a file that will create a compatible shape that 
can be imported into the VariQuest software and cut with 
the VariQuest® Cutout Maker 2800 MyShape™ feature. See 
the Formatting section for more details.
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2.	 Identify any objects that have a Mesh effect applied. These objects need to be either deleted 
or Rasterized (Object > Rasterize) and re-converted to a vector shape using the Image Trace 
feature (See Designing a Shape Using Image Trace)

Note: Objects with a Mesh effect applied will appear distorted in the software and fail to cut properly.

3.	 Identify and release any Clipping Masks used in the document by selecting the artwork, right-click 
on the image, and choosing Release Clipping Mask

Note: The VariQuest software does not recognize Clipping Masks and will cut any objects hidden by a mask.

4.	 Make sure all objects with a stroke have a Uniform Variable Width Profile and the Brush 
Definition is set to Basic—any other stroke type will not import properly to the VariQuest® software



7

DESIGN PROCESS

5.	 To ensure that no other effects are applied to the image, select 
everything on the artboard (Ctrl+A), go to Object, click Expand, 
make sure all available options in the Expand dialog box are 
checked and click Okay

Note: If Expand is disabled in the Object menu, click Expand Appearance—
go back to Object and select Expand.

6.	 Once all elements in the graphic have been converted or 
expanded, copy the artwork to the new document, and resize to fit 
the artboard created at the shape’s minimum cut size

7.	 If the graphic is not already a two color graphic, it will need to be 
manually converted to a black and white image by changing the fill 
color of all objects on the artboard to either black or white—keeping 
in mind that objects in black will be the main shape, and white 
objects will be relief cuts that fall away when the shape is lifted off 
the cutting mat.

The resulting image is now ready to be tweaked and formatted into a file that will create a compatible 
shape that can be imported into the VariQuest® Design Center software and cut with the VariQuest 
Cutout Maker 2800 MyShape™ feature. See the Formatting section for more details.
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FORMATTING
Although the files created in the previous section technically can be read and cut by the Cutout Maker 
2800, further formatting is necessary in order to create a shape that cuts efficiently and that keeps the 
integrity of the image. 

Creating a Solid Background
Following the previous design scheme, objects with black fill will be the main shape, while white objects 
will be cut away and discarded. Due to the way the Cutout Maker reads vector paths, the graphic needs 
to contain a solid background object—this will be the path that cuts the outline of the shape and must be 
a closed polygon. If this is not already included in the artwork, the black objects on the artboard need to 
be combined to make one solid background shape.

Note: Make sure all relief cuts are objects with white fill. Double check to confirm that none of the black objects 
contain any compound paths that appear white on the artboard. To convert a compound path to an object, 
draw an object with white fill over the path, send the object to the back of the artboard (Ctrl+Shift+[), and click 
the Trim button in the Pathfinder panel. Ungroup (Ctrl+Shift+G) the resulting objects and proceed to Step 1.

1.	 Using the Magic Wand tool  (Y), click the black background to select all objects with black fill

2.	 Click the Unite button  in the Pathfinder panel (Window > Pathfinder)

3.	 Switch back to the Selection tool  (V), double-click on the black object 
to enter Isolation Mode 

4.	 Delete all paths and anchor points inside the main object, resulting in a 
solid black shape

5.	 Click the back arrow  in the upper left-hand corner of the pasteboard twice to exit Isolation Mode

6.	 Send the solid black shape to the back of the artboard to reveal the white shapes by right clicking 
on the selected object, clicking Arrange, and selecting Send to Back - or by using the keyboard 
shortcut Ctrl+Shift+[
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Guidelines for Manipulating Relief Cuts
Now that the background is a solid shape, the white objects need to be manipulated to make it easier for 
the Cutout Maker to make accurate cuts that keep the integrity of the original image. 

Here are a few guidelines to keep in mind:

•	 4″ by 4″ is a good starting point for the minimum cut size of most simple shapes. 

	» If, at any point in the design process, the following guidelines seem to compromise the integrity 
of the image, try increasing the minimum cut size.

•	 At the image’s minimum size, all inside cuts need to be at least 1/16″ wide.

	» Use a .0625 in circle to test if needed (or a 4.7pt 
stroke if making a line to expand). 

	» An inside cut narrower than 1/16″ will run the risk of 
tearing while cutting, making a distorted cut, or not 
cutting at all.

•	 Relief cuts need to be at least 1/16″ apart and away from 
any edges.

	» Cuts that are too close together (or to the edge) can 
cause the paper to tear while cutting, or will create a 
weak connection that can easily be broken.

•	 All text must be Expanded (Object > Expand).

	» Any text created with the Type tool that hasn’t been 
expanded will not preview in the software, and will 
not cut.

•	 Rounding off corners will give a more accurate depiction of what the shape will look like when cut.

	» Sharp angles will automatically be rounded off when 
the file is run through the VariQuest® software.

	» Keep the 1/16″ limitation in mind when working with 
sharp angles and corners.

•	 Unless a shape is being designed specifically for vinyl cutouts, all areas in black need to be 
connected to the main shape. 

	» Any part of the black background that is fully surrounded by a white shape will fall away from 
the main shape when lifted off the cutting mat. Common examples of this include:
	· Lettering inside a shape
	· Borders or backgrounds inside a shape
	· Spots or freckles
	· Noses and eyes
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	» While some non-essential objects may need to be removed altogether, most common issues 
can be resolved by creating a bar, or other organic shape, and subtracting it from the white 
object to make a connection back to the main shape. 

1.	 Use the Rectangle tool  (M) or the Pen tool  (P) to draw a bar (or other organic 
shape) at least 1/16″ wide

2.	 Select the bar and white object, then click Minus Front button  in the Pathfinder panel

3.	 Make sure sharp edges are rounded out, keeping the 1/16″ limitation in mind



11

FORMATTING

4.	 If the result is not satisfactory, continue to manipulate anchor points using the 
Direct Selection tool  (A) until desired effect is achieved

TIP: When creating text for a cut shape, considering using a stencil font, such as GarretVQ Stencil.

•	 Make sure any long, thin elements of the design are broken up and anchored to the main shape.

	» Long, thin pieces or cut outs are more difficult for the Cutout Maker to cut without tearing (horse 
legs, cow tails, etc.). Attaching these pieces back to the main object can often make the image 
more functional.

	» The same concept is applicable to inside cuts—relief cuts that aren’t broken up in enough 
places will create a flimsy cutout that can easily be broken and torn.

	» Use the same methods from the previous guideline to ensure the relief areas have enough 
connections to create a sturdy, solid shape.

•	 Make sure all objects in a shape are closed polygons.

	» It is important to make sure all anchor points in an object are joined to create a complete 
shape. Any gaps between anchor points, or anchor 
points that are not joined to complete a closed 
polygon will register as a line rather than a relief cut.
	· To close an incomplete polygon, select the two 

anchor points that are not connected with the 
Direct Selection tool (A), right-click and select 
Join, or use the keyboard shortcut Ctrl+J.

	» Any line with a stroke that is intended to be a relief 
cut needs to be expanded to an object. 
	· The VariQuest® software does not register the 

weight of a stroke, and will only cut a slit in the 
material along the line path. To expand a stroke, 
select the line, go to Object, and click Expand.
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Note: Paths with a heavy stroke setting that have sharp 
angles, or any path that crosses over itself, will 
convert to a shape that has overlapping outline 
paths when expanded. These objects need to be 
united (select object and click Unite button in the 
Pathfinder panel) in order to create a solid object.

	· Lines are typically only used in cut shapes to create a dashed, perforated edge for folding.

Note: The VariQuest software does not recognize a Dashed Line effect applied to a stroke. Dashed lines must be 
created manually with individual line segments.

•	 Try to simplify the images as much as possible.

	» There should be as few anchor points as possible to eliminate 
blade movement.

	» An easy way to quickly decrease the number of anchor points in an 
object is to:

1.	 Select the path, or paths

2.	 Go to Object

3.	 Click on Path

4.	 Select Simplify

5.	 Toggle the slider until the least 
amount of anchor points are 
present on the path without 
affecting the integrity of the shape

Once a shape has been properly formatted, and the above guidelines have been met, the file needs to 
be finalized and saved in a format the Cutout Maker 2800 can process.
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SAVING & EXPORTING
At this stage in the design process, all the objects for the shape are present and in their final position 
on the artboard, but now they need to be layered in the right order.

Document Clean-Up
Before saving the final file, make sure to delete any unnecessary elements used or 
created in the design process.

•	 Look for, and delete any invisible paths (a path without a fill or stroke color 
that appears hidden).

	» Use the keyboard shortcut Ctrl+A to select all objects on the artboard and 
look for objects that don’t belong.

	» Go to View and select Outline (Ctrl+Y) to see all paths on the artboard in 
Outline Mode.

•	 Delete any and all guides present in the document.

	» Document guides may be used during the designing 
process, however they MUST be deleted before 
saving, or the software will generate an error 
message and deny the file for import.

1.	 Go to View

2.	 Click Guides

3.	 Select Clear Guides

Object Layering
It is important to save the file with the object layers already 
set up for the correct cut order. 

The Cutout Maker will always cut from the bottom layer to the 
top layer in the Layers panel . Order the individual shapes 
in the most efficient way possible to enhance cut time and to 
minimize blade movement—starting at the top most shape and 
ordering left to right. When possible, the smallest objects 
should be cut first, and larger objects toward the end.

The main shape should always be to the front (the top layer 
in the Layers panel) to minimize the amount of unnecessary 
movement of the paper.
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•	 The outline of the main shape should be the last object cut. If the 
outline is cut earlier in the process, it could cause the paper to shift 
and tear while cutting the rest of the shape.

Note: When the main shape (which, in this demonstration 
is a solid black object) is moved to the top layer in 
the document, it may appear to obscure the rest of 
the objects on the artboard.

File Formatting
Now that the shape has been designed, formatted, cleaned up and properly layered, it is ready to be 
saved to its final file format.

The VariQuest® Design Center Software currently only supports Adobe® Illustrator® files saved down 
to Illustrator Version 3. To save a file down to Illustrator 3 from the current version of Adobe Illustrator:

1.	 Go to File

2.	 Select Save As...

3.	 Choose the desired file location and enter a unique name 
that describes the shape

4.	 Select Adobe Illustrator (*.AI) from the Save as type 
drop-down menu

5.	 Click Save

6.	 Select Illustrator 3 from the Version drop-down menu in 
the Illustrator Options window

7.	 Click OK

Note: A message window may pop up with a warning about editing 
features being disabled when saving to a legacy format. Click 
OK to disregard.

Once saving is complete, the file is ready to be imported into the Design Center Software, via the 
MyShape™ function.

Exporting
Be sure to save a copy of the final shape file on the Desktop, or in an easily accessible location.

If the newly designed shape is going to be installed on another device (for example, the 
Design Center 2300), the easiest way to transfer the file is to copy it onto an external flash drive.
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IMPORTING

Importing a Shape Using the MyShape™ Feature
To begin uploading a shape to the VariQuest® Design Center Software, make sure the Cutout Maker 
2800 is connected to the Design Center 2300 (or other device with the VariQuest software installed), 
and powered ON. Insert flash drive, if using.

1.	 Open the VariQuest Design Center Software

2.	 Click on the Cutout Maker 2800 button

Note: The MyShape feature is not available for the Cutout Maker 1800.

3.	 Click the MyShape™ button on the Output Type screen

4.	 Select Import on the right side of the MyShape page

5.	 Browse out to, and select the Adobe® Illustrator® file

6.	 Click OK

7.	 A message window will open, indicating a successful 
import—click OK

Note: If the software issues an error message, see the 
Troubleshooting section to identify and fix the issue, then 
re-save and import again.

Once the shape has been successfully imported, the 
software will return to the MyShape screen. From this page, 
one can either Open the shape and proceed to cut, Delete 
the shape, or Import another shape.
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•	 To access a custom shape from the Shapes page:

1.	 Open the VariQuest Design Center Software

2.	 Click the Cutout Maker 2800 button

3.	 Select the Shapes button

4.	 Choose Browse Categories

5.	 Click on the -My Shapes category 
at the top of the Categories list

6.	 Select the Your Imported Shapes 
Subcategory

7.	 Locate the shape from the 
thumbnail list on the right

8.	 Click Okay and follow the 
on-screen prompts

Finding an Imported Shape in the Software
All imported shapes will be saved to, and can be opened from the MyShape™ screen—however, any 
shape imported using the MyShape feature will also be available in the Cutout Maker 2800 software 
in the -My Shapes category with its own unique Search ID.

•	 To access a custom shape from the MyShape page:

1.	 Open the VariQuest® Design Center Software

2.	 Click the Cutout Maker 2800 button

3.	 Select the MyShape 
feature button

4.	 Locate and select the 
custom shape from the 
list of installed shapes

5.	 Click Open and follow 
the on-screen prompts
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•	 To access a custom shape using its unique Search ID, repeat 
steps 1-7 for accessing a shape from the Shapes page and 
make a note of the ID# at the top of the pop-up window.

1.	 Open the VariQuest® Design Center Software

2.	 Click the Cutout Maker 2800 button

3.	 Select the Shapes button

4.	 Choose Search by Keyword

5.	 Enter the shape’s Search ID

6.	 Click Next

7.	 Select the shape, click Okay and 
follow the on-screen prompts

Once an imported shape has been added to a cut job, follow the on-screen prompts to customize the 
size and number of shapes, add shapes or letters, and proceed to load paper and follow the prompts on 
the Cutout Maker 2800’s LED screen in the same manner as any regular cut job.
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TROUBLESHOOTING
If, after following the instructions detailed in this guide, a shape fails to import, or does not cut correctly, 
refer to the troubleshooting tips below.

Troubleshooting Tips
• An warning message regarding a potential error in the file appears 

when attempting to import a shape

» Check the thumbnail in the File Preview window to make sure the
shape is previewing correctly. If the image is blank or distorted,
continue to The File Preview thumbnail appears blank or distorted
when file is selected for import.

» If the File Preview image looks correct, click the button to disregard the message and import 
anyway. Proceed to cut the shape to test for any other errors addressed in the following 
Troubleshooting Tips.

• The File Preview thumbnail appears blank or distorted when file is selected
for import

» Check to make sure the file type is correct. See File Formatting in the
Saving & Exporting section for instructions on saving an Adobe® Illustrator®  
file down to Illustrator 3.

» Confirm that no guides are present in the document. See
Document Clean-up in the Saving & Exporting section for more
information.

» Make sure all objects are closed polygons. See File Formatting
in the Saving & Exporting section.

» Double check the artwork for any applied effects or styles
that may have been missed. See File Formatting in the
Saving & Exporting section for more information.

» If none of the suggestions above fix the issue, try manually tracing over the
image with the pen tool set to basic and save the new artwork in a clean
document.

• An error message regarding File Type appears when attempting to import a shape

» Check to make sure the file type is correct. See File Formatting in the Saving & Exporting
section for instructions on saving an Adobe Illustrator file down to Illustrator 3.

BONUS TIP: If the art for a custom shape is saved as an SVG file, open the file in Adobe Illustrator 
and re-save the file as Adobe Illustrator 3.
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•	 The shape appears inverted in the preview thumbnail when imported

	» Create a new layer in the document, cut and paste the artwork into the 
new layer, delete the original layer. 

	» Check to make sure there is not an object or path surrounding the artwork.

	» Re-save and try to import the shape again.

	» If none of the suggestions above fix the issue, try manually tracing over the 
image with the pen tool set to basic and save the new artwork in a clean 
document.

•	 No confirmation message window appears when importing a shape and 
screen returns to MyShape™ page 

	» Check the MyShape list for the file intended for import, as it may have already been uploaded 
to the software.

•	 An imported shape does not cut as intended and needs to 
be replaced

	» If a problem has been identified with a shape that has 
already been imported using the MyShape feature, locate 
and select the shape in the list on the MyShape home 
screen, and click Delete. Open the Adobe® Illustrator® file, 
make the necessary changes, re-save the file down to 
Illustrator 3, and Import again through the MyShape feature.

•	 The Cutout Maker cuts the same object multiple times

	» Confirm each object has only one path, there are no objects layered on top of each other, and 
there are no compound paths in the document.

Note: When using the Image Trace feature, if Abutting is the selected method in the Advanced section instead 
of Overlapping, the resulting artwork will contain cutout paths rather than stacked paths. This means each 
object in the graphic will contain its own path as well as the compound path of the object surrounding it, 
resulting in the Cutout Maker making the same cut around an object twice.

Abutting Overlapping

	» Check for objects with no fill or stroke that appear hidden when not in Outline Mode. See 
Document Clean-up in the Saving & Exporting section for more information.
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•	 Some elements of the shape are cutting smaller, shorter, or rounder than intended

	» Increase the size of the shape in the artwork file. Re-save the file, delete the previous 
version of the shape in the software, and import the updated file. See Document Setup in the 
Getting Started section for information on minimum cut size.

BONUS TIP: Try testing this in the software first. Add the shape to a cut job several times, increasing the 
size of the shape each time. Make a note of which size cuts the most accurately, and adjust 
the minimum cut size in the artwork accordingly. 

•	 The software issues a warning that the object will be tiled when 
added to a cut job

	» The size of the shape is too large to fit on one sheet of 12″ x 18″ 
Cutout Maker media.
	· Test cut the shape at a smaller size. If the result is acceptable, 

decrease the minimum cut size of the shape in the artwork file and import again.

BONUS TIP: Due to the safety margins in the Cutout Maker’s programming, a best practice is to design a 
single cut shape no larger than 11.5″ x 17.5″ to avoid shrinking the minimum cut size when a 
shape is added to a cut job.

	· If the shape is intended to be larger than 12″ x 18″, manually split the shape into two pieces, 
and save out as two separate shapes. 

Note: If a shape is larger than 11.5″ x 17.5″ and the warning message is dismissed, the software will arbitrarily split 
and tile the shape on its own—often with less than satisfactory results.

•	 The software issues a warning that the object is being cut smaller 
than the minimum cut size when added to a cut job

	» Dismiss the warning to test cut the shape at a smaller size. If the result 
is acceptable, decrease the minimum cut size of the shape in the 
Adobe® Illustrator® file and import again.

	» If the result of the test cut is not acceptable, refer to the Guidelines for Manipulating Relief Cuts in 
the Formatting section to modify the problem areas, or proceed to cut the shape at a larger size.

•	 Dashed lines cut as a solid line

	» Make sure dashed lines consist of individual line segments, and not a dashed stroke effect. 

	· The VariQuest® software does not recognize a Dashed Line effect applied to a stroke. 
Dashed lines must be created manually with individual line segments. See Guidelines for 
Manipulating Relief Cuts in the Formatting section for more information.
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•	 Objects cut into each other in unintended ways

	» Make sure there are no overlapping paths on the artboard. 
	· Check to make sure there are no paths without a 

stroke or fill in the document, as paths that aren’t 
visible will still register and cut—see Document Setup 
in the Getting Started section.

	· Unite overlapping objects intended to cut as one. 
Select all objects that need to be combined, then click 
the Unite button  in the Pathfinder panel.

	· Check to make sure that any objects with a weighted 
stroke that have been expanded do not overlap any 
other paths.

Note: When a closed polygon with a weighted stroke and a fill is 
expanded, the individual objects generated for the stroke and 
the fill color will overlap. See the Formatting section for designing 
guidelines.

•	  Text is not present and does not cut

	» Make sure all text in the Adobe® Illustrator® file has been expanded. The Cutout Maker does 
not register live text, all glyphs need to be converted to objects in order to cut. See Guidelines 
for Manipulating Relief Cuts in the Formatting section for more information.

Custom Shape Program
For those that haven’t yet upgraded to the Cutout Maker 2800—
or for the complex shapes that require a bit more assistance—
the VariQuest® Custom Shape Program is available to all 
Cutout Maker customers! Complete the Custom Shape Request 
Submission Form to work directly with our graphic designer to 
turn a custom image into a fully qualified Cutout Maker shape!

View the Custom Shape Program Flyer for more information.

Support
Questions? 

For further assistance with the MyShape™ feature for the Cutout Maker 2800, don’t hesitate to reach out 
to the VariQuest Technical Support Team:

	· 1-800-328-0585 (ext 3)
	· tech_support@variquest.com

To inquire about the Custom Shape Program, contact VariQuest Customer Service at: 
	· 1-800-328-0585 (ext 2)
	· customerservice@variquest.com

https://info.variquest.com/cm-custom-shape-request
https://info.variquest.com/cm-custom-shape-request
https://info.variquest.com/hubfs/images/Products/Cutout_Maker/cutout%20maker%20custom%20shape%20flyer%202.14.23.pdf
mailto:tech_support%40variquest.com?subject=Cutout%20Maker%202800%20MyShape%20Feature%20Inquery
mailto:customerservice%40variquest.com?subject=Custom%20Shape%20Program%20Inquery
https://info.variquest.com/cm-custom-shape-request
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GLOSSARY
Anchor Point

In Adobe® Illustrator®, an anchor point is a point on a path that controls the shape and 
direction of the path.

Artboard
In Adobe Illustrator, an artboard is a blank canvas on which designs are created. Artboards 
are similar to pages in a word processing program.

Basic Shape
A basic shape is a single cut shape found in the Shapes portion of the VariQuest® Design 
Center Software for the Cutout Maker. Shapes with multiple layers and shapes grouped 
together to form a larger craft or project (such as a bulletin board or door decoration) are 
found in the Collections portion of the software.

Brush Definition
A brush in Adobe Illustrator is a custom template that can be used to change the 
appearance of a path’s stroke. The Brush Definition drop-down menu allows one to view 
and select a range of brush options.

Clipping Mask
A Clipping Mask in Adobe Illustrator is a shape that defines the visible area of an image 
or artwork. It’s a group of layers where the bottom layer, or base layer, determines what’s 
visible.

Closed Polygon
In Adobe Illustrator, a closed polygon is a connected series of line segments that form a 
shape by joining the start and end points

Compound Path
A compound path in Adobe Illustrator is a path with holes that allow one to see objects and 
colors behind the path.

Cut Job
When going through the process of utilizing the Cutout Maker to make cutouts and 
decals, a cut job is the collection of shapes and letters selected to be cut during any given 
session. Once a shape is selected, an edit screen appears where one can change the size 
of the shape, choose the number of shapes in the job and add more shapes to the job. 
The option to save the cut job for future use is given before proceeding to cut the selected 
shapes.
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Design Center 2300
The VariQuest® Design Center 2300 is an easy-to-use touchscreen-enabled workstation 
that comes pre-loaded with the VariQuest Design Center Software required to operate the 
Cutout Maker.

Direct Selection Tool
The Direct Selection tool in Adobe® Illustrator® allows users to select, move, and modify 
specific points in a shape or path. This tool is useful for reshaping paths, adjusting anchor 
points, and editing text.

Effects
In Adobe Illustrator, an effect is a function that can be applied to objects to change their 
appearance.

Expand
In Adobe Illustrator, the Expand command converts text, lines, patterns, and shape strokes 
into vector shapes with outlines. The Expand Appearance command converts a line into 
the shape of the effect applied to it.

Fill
In Adobe Illustrator, a fill is a color, pattern, or gradient that can be applied to the inside of 
an object.

Flat Image
A flat image is an image that has been combined into a single layer. It is a non-editable 
graphic that cannot be manipulated by vector points.

Group/Ungroup
In Adobe Illustrator, grouping combines multiple objects into a single container, while 
ungrouping separates them again.

Guide
In Adobe Illustrator, guides are lines or dots that can be moved around a page to help with 
alignment and measurement. They are a built-in feature that are only visible in Illustrator 
and not in the final product.

Image Trace
Image Trace is a feature in Adobe Illustrator that automatically converts pixel-based 
images into vector artwork. This process is also known as autotracing.

Isolation Mode
Isolation mode in Adobe Illustrator allows one to focus on a single object or group of 
objects while dimming and locking the rest of the design.

https://variquest.com/learning-suite/design-center/
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Join
In Adobe® Illustrator®, the Join function connects paths at their intersection points and 
trims excess lines. It can also close gaps between open paths.

Layers
In Adobe Illustrator, layers are transparent folders that organize content like images, text, 
and artwork. Layers are stacked in the Layers panel, with the top layer appearing in front 
of the layers below.

Line
In Adobe Illustrator, a line is a path made up of anchor points at the beginning and end, 
connected by a path. Lines can be drawn using the Line Segment tool, the Pen tool, or the 
Pencil tool.

Minimum Cut Size
In the VariQuest® Design Center Software, the minimum cut size is the smallest size a 
shape has been qualified to cut at. This is the size the shape was designed at, and it is not 
guaranteed to produce a quality cut if an attempt is made to cut the shape smaller than 
the minimum cut size.

Object
An object in Adobe Illustrator is any item that a user creates or adds to a document. This 
includes shapes, paths, rasterized artwork, 3D objects, and placed files.

Outline Mode
Outline Mode in Adobe Illustrator is a view that shows vector paths as simple outlines. 
It can be useful for seeing the structure of an illustration, selecting shapes, and editing 
vector paths.

Path
A path in Adobe Illustrator is a series of line segments that can be straight or curved.

Pattern Stroke
A pattern stroke in Adobe Illustrator is a stroke that uses a pattern brush to fill in an object 
or its outline. A pattern brush is a group of objects that are repeated along a path, and the 
objects will stretch to match the shape of the path.

Rasterize
Rasterizing in Adobe Illustrator converts vector graphics into raster graphics, which are 
made up of pixels. To rasterize is to convert a vector graphic to flat image.

Selection Tool
The Selection tool in Adobe Illustrator is a tool that allows users to select, resize, and 
rotate objects, or groups of objects.
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Stroke
In Adobe® Illustrator®, a stroke is a line or outline that defines the shape of an object, path, 
or text. Strokes can be customized in terms of color, thickness, and style.

Stroke Weight
In Adobe Illustrator, stroke weight is the thickness of the line or outline around an object. 
Strokes can be used to add detail, define shapes, or create borders.

Unite
The Unite function in Adobe Illustrator merges multiple shapes into a single object. It’s 
located in the Pathfinder panel.

Variable Width Profile
The Variable Width Profile menu in Adobe Illustrator allows users to create and apply 
custom width profiles to strokes and paths.

VariQuest® Design Center Software
The VariQuest Design Center Software is a program that allows users to create custom 
visuals for classrooms and schools. This is the application used to operate the Cutout 
Maker, and where Cutout Maker 2800 users will find the MyShape™ feature.

Vector Graphic
A vector graphic is a graphic created using mathematical formulas, points, lines, and 
curves. Vector graphics are resolution independent, meaning they can be scaled to any 
size without losing quality.

https://variquest.com/learning-suite/design-center/
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